Introduction to Maya

aya is a powerful 3D modeling, animation, effects, and rendering
solution that has been used in everything from product design to
feature films. In capable hands, it can produce any sort of image ima-
ginable, from an impressionistic painting to highly realistic anima-
tion and special effects.

Because of its power, Maya has a wealth of features and can seem complex at first
glance. But this shouldnt overwhelm those new to the package. Getting to know a major
piece of software such as Maya is much like getting to know a large city. First you need
to look at a large map of the city to get a general overview, and then you explore it a
neighborhood at a time. Essentially, that's how this book works. This first chapter intro-
duces you to a general map of Maya and helps you get used to navigating the software.
Subsequent chapters explore sets of features such as modeling, rendering, and anima-
tion in greater depth. When you take it a step at a time, Maya is easy to learn and use. (1
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The Maya Interface

Knowledge of the Maya interface is the foundation of everything you will do in Maya, from creating models to tex-
turing, animating, and final rendering. Maya offers a lot of flexibility, and you can customize it in myriad ways.

QWERTY tools Used to
manipulate objects and
named after their keyboard
shortcuts: (Q) Select, (W)
Move, (E) Rotate, (R) Scale,
(T) Show Manipulators, and
(Y) Repeat Last Tool. ----.

modeling, dynamics,

Viewports Primarily used to
see your 3D scenes through
camera or orthographic views.

Menu sets Let you switch
between sets of menus for
the tasks of animation,

rendering, and cloth.

Main menu bar Contains
standard menus (File, Edit,
Modify, Create, Display,
Window) followed by menu
items that are displayed or
hidden depending on the
selected menu set.

Status line Contains icons
used for a number of
important tasks, such as file
operations, object and
component selection,
snapping, and rendering.
Each logical group of icons is
separated by a vertical bar.

Viewports can also contain |
data about the scene, such as ;.
with the Hypergraph or the ’
Multilister.

Layouts Instantly changes
the configuration of the
viewports to a number of
preset layouts.
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Time slider Lets you ﬁove
left and right to scrub
through the scene.

Range slider Limits the
range of the Time slider. This
is handy for long scenes,

of the tools and how to use
them.

when you want to focus on a
smaller segment of time.

The Status Line

Z " Shelf A place to set your

own custom tools and scripts
to speed up work flow.

" Channel box Contains data
about the selected objects,
such as position, rotation,
and scale.

-- Playback controls Let you
play, stop, rewind, and step
through your animation.

“*Help line A short description

" Command line A place to
type text-based commands to
Maya, such as a MEL script.
Custom MEL scripts can help
automate any number of
tasks.

The Status line contains a lot of important icons that assist you with tasks such as manag-
ing files, selecting masks, snapping, and rendering options.

Scene File
Contains icons
that let you open,
save, and create
new scenes

Menu sets Let you switch
between sets of menus for
the tasks of animation,
modeling, dynamics,
rendering, and cloth

Selection masks
Let you decide
which components
are selected when
you're in compo-
nent mode

Snapping
functions Snap
the cursor or
objects to specific
parts of the scene

Select1on modes
Let you select by
hierarchies,
objects, and
components

Presets A list of preset
component types for use
with selection masks
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Name selection”
Lets you select
objects by name
or part of a name

Render controls
Contain icons
used to render the
scene and control
rendering options

Input/output connections
Manage the way objects are
connected as well as
construction history

sE'Iv

Channel box buttons Three
buttons that let you show and
hide the Attribute Editor, tool
settings, and Channel box



The QWERTY Tools

These tools are used for selecting and translating and
are accessed primarily through the shortcut keys Q,
W,E, R, T and Y.

- Select (Q) Selects an object or, by clicking and
dragging, multiple objects
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L - Lasso Selects object(s) by drawing a lasso
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.~ Paint Selection Selects components by painting
over them

-~ Move (W) Moves the selected object(s)
- Rotate (E) Rotates the selected object(s)
-- Scale (R) Scales the selected object(s)

-~ Universal Manipulator Combines the functional-
ities of the Move, Rotate, and Scale tools

" Soft Modify Allows modification of the object with
falloff

AP $BIER,

" Show Manipulator (T) Shows the manipulator,
allowing you to adjust construction history.

" Last (Y)~MSSelects the last tool used

Floating Menus

The Maya Interface

(3

Layouts

The Layouts tool box quickly changes the arrange-
ment and layout of the viewports. The viewport
arrangement you choose depends on the task at hand.
If you are texturing and lighting a scene, you'll want
the Hypershade available. An animator will need easy
access to the Graph Editor. Clicking any of the preset
buttons instantly changes the views as follows:

.- Single perspective

.- Four perspectives

.- Perspective and Outliner

.- Perspective and Graph Editor

.- Hypershade and Perspective
.- Perspective, Graph Editor, and Hypergraph

- Mode select: Each button reveals a rollout allowing
you to change the mode of the corresponding
view.

In Maya, you can tear off and “float” drop-down menus when you need repeated

[ [ o—
access to the menu. Simply left-click the double bar at the top of the drop-down. Transformation Tools ’
Reset Transformations =}
W Create Display ‘Window Edit C Freeze Transformations o
& ...
Transformation Tools 4 Snap Align Objects 4
Reset Tfar‘f‘:f"'a"m“‘ g Left-click here to float the Align Tool
Freeze Transformations window. snap Together Tool o
Snap Align Objects b
Align Tool Evaluate Nodes 4
Snap Together Toal [n ]
Make Live
Evaluate Nodes b ]
Cenker Pivat
Make Live Prefix Hierarchy Names. ..,
Center Pivot
Prefix Higrarchy Mames... Search and Replace Names...
Search and Replace Names... add Attribute
Add Attribute. .. Edit Attribute. ..
Edit Attribute. .. ;
Delete Attribute. . Delete Attribute...
Corvert 3 Convert 4
Paink Scripts Tool o Paint Scripts Toal [a]
Paint Attributes Tool o Paint &ttributes Tool =}
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The Hotbox

Another way to easily access menus is by using the hotbox, which appears when you press
the spacebar. The hotbox places all the menu commands at your cursor. You can customize
the hotbox to include all the available tools or only those currently needed.

Recent Commands A list of Common menus The Panel menus Menus Hotbox Controls Lets you
the last tools used; handy standard menus from the associated with the active show and hide menus and
when performing the same menu bar. -.. panel. . menu sets as well as control
operations on different ; hotbox display options, such
obejcts. as transparency.

|ri= Edt  Maodfy Creste  Disply  Window  Help

WView Shading Lighting Show Renderer Panels ‘| -

T Mara Hotbow Contrals | .o.--c=0777 77

| Laghting/5 hading Terluimg  Render Toon  Paint Effects  Han  Fur

|Pa_lljc|u Fluid Effects  Fields  Soft/Rigid Bodies  Effects  Solvers Hair|

Clath Constraints Simulation

Scene Track Solve LiveConstraints LivePanels |

% L atkey Cditar

Catmgoriss inds. Currans. [ioikaps
; w - Fin
View select Clicking in the - Menu sets Menus that are fe | T —_—
center box lets you change contained within the menu I |7 R i
the view in the current sets and can be turned £ s o= N[5
viewport. on/off using the hotbox feain, g e R, R
co ntrO l.S. ?E”"E"m wx‘;xzzm’m ™ 8 In ereed wovvmerd 1
Dlr-£iheza Yo
LConstsn AnaE e
Pt Fimrbr 1 O |
&'}i[ﬁeﬂs |$m_§uthckl
. mo R
Marking Menus .
Leszizion G 2 1o sczrm B |
. . . ooy | R | = |
Marking menus let you quickly access functions wherever the P —
cursor is located. Once you memorize a marking menu, you can e -
Hep
quickly select options with a simple keystroke and mouse ges-
ture. Maya has a number of preset marking menus. You can cus- e ] |
tomize the interface to your own needs using the Hotkey Edi- ) .
. ) . ) You can configure and customize hot keys and
tor, which lets you assign a marking menu to a particular key. marking menus using the Hotkey Editor (choose
Here are a few standard marking menus: Window — Settings/Preferences — Hotkey Editor).

: B i
T Vove optons_| e
B ey | O bl H@' Roteke Options |

O 5nap Move m] Relative Mode |  ENE Use Chiject Fivat |
1 Relative Mode O Snap Rotate

B Update Triad
O Reflection

Holding down the W key while pressing  Pressing the H key selects Pressing the E key displays the options for rotat-
the left mouse button opens a marking  the menu set. ing objects.

menu that gives you options for mov-

ing objects.



The Channel Box

Clicking this button [#], which is on the far right of the Status line, displays the Channel
box. The Channel box sits along the right side of the interface and lets you quickly edit an
object’s main attributes. Translate, Rotate, and Scale are the most common attributes, but
the Channel box provides control over many parameters of an object. It can also act as an
animation interface, in which you can key parameters simply by right-clicking. You can
also lock attributes so they can’t be changed. This is helpful when the object needs to

remain stationary, for example.

Mode Switches between Channel box, .

Layer Editor, or both.

Channels Drop-down menu that lets
you key attributes, copy and paste
attributes, and lock or unlock attributes.
This menu is also available by right-
clicking over the Channel box.

Object If multiple objects are selected,

lets you show the individual channels of

any one object.

Attributes Attributes for the object,
such as Translate, Rotate, and Scale,
along with others. You can change
these by typing new values or by
highlighting the attribute(s) and then
dragging the mouse while holding
down the middle mouse button.

- EEEE

i@ |

Channels . Object

pSpﬁéle‘[
" Translate X 0
TranslateY 0
Tranglate £ 0
Rotate X 0
.~ Rotate’y 0
" RotateZ 0
Scalex _
Scale v AN -

Scale Z [N
Visibility on

SHAPES
__pSphereShapel
INPUTS ... e
fid1 :
tweakl
Envelope 1
Local Influence S 2
Local Influence T 2
Local Influence U 2

@ Display  Render
Layers Options Help

<« | >

The Maya Interface
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Locked attributes To lock or unlock an attribute,
highlight the attribute, and then right-click to
display the Channels menu, which has the lock and
unlock selection command.

Inputs Modifiers that change the object.

- Input attributes Modifiable attributes related to

the selected input.

- Layer Editor Controls layering.
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The Attribute Editor

The Attribute Editor is an important window in Maya and takes the concept of the Channel
box a step further. Every object in Maya is defined by a collection of attributes, such as its
position, color, shading, shape, and so on. The Attribute Editor is the interface where you

can control and modify these attributes in detail.

The Attribute Editor has a series of tabs representing the nodes connected to the main
object. Each node affects the object in a specific way, from altering the shape of the object
to determining its shading.

Clicking this button [&], which is on the far right of the Status line, places the Attribute
Editor on the far right of the screen. You can also open the Attribute Editor by choosing
Window — Attribute Editor from the menu bar. Pressing Ctrl+A / 88+A also displays the
Attribute Editor for the selected object. e

. . .
""""""" List Selected Focus Attributes Help

Main menu Menus to control the ---
Attribute Editor.

List Lets you load attributes
A = =~ manually or automatically
.-~ | pSpherel | pSphereShaps | pephereshapetia | el | weskt | st L1} when the object is selected.
Nodes Tabs that contain attributes for e [pspmﬂ— w) | Foous™|
each node connected to the object. B | _Pesss [ - Selected If multiple items
These can be nodes that contain Sl — - — are selected, lets you display
% ranshorm i es

attributes used to modify the shape of —— WWW “|". the attributes of any one

the object, apply shaders, and so on. Rotet [G000 [ G0 B object.

R Scake [2.293 [2000 PN
Transform Attributes Translate, Rotate, Shear [0000  [0000 o000 . "Focus Displays all nodes that
and Scale attributes for the master Rotate Oicer [z +] have been selected in the
node. Rotate dvis [0000  [0.000 [o.000 scene while the Attribute

W Inheits Transfomn Editor is open. The most

Pivots Lets you display a separate -~~~ =l Pivans I Display Rotate Pivat recently selectgd node is at
rotate and scale pivot. I Display Scale Pivot the top of the list.

|L Local Space
R |L World Space
Local/World Space Lets you adjust the [+ Limit information

L. Attributes Lets you add,

rotate and scale pivots to local and " |[+[ Display ' edit, and delete extra
world space. ; I Display Hande attributes for an object or a
-+ I DisplayLocal s node. These appear in the

; ; Selection Handle [0.000 Jo.00g Jo.000 Extra Attributes section. You
Limit Information A series of rollouts " Show Marip Default | None -] can also add, edit, and delete
that let you limit the object’s transla- | Matip History Node | attributes using the Modify
tion, rotation, and scale. I Visibiity I Template men.

- o ¥ LOD Visibiity
‘¥ | Ghosting Information

Display Attributes that control how an - rlj Bounding Box Information . ------ Notes Each node can contain
object is displayed. " JL2] Drawing Dverrides notes to aid in documentation.

¥ | mental ray
3 |L| Node Behavior
|_>_| Extra Attributes

Display Handle When checked, displays
a handle with which to select the 2
object.

Rollouts Contains more parameters. *

Notes: ffd1Lattice

Extra Attributes Any node can contain -
custom attributes defined through the
Attributes drop-down at the top of the
Attribute Editor.

Select Load Attibutes Copy Tab



Viewports (7

Viewports

Viewports are where most of the work in Maya happens. Viewports can hold views of your
scene as well as other types of windows that display information about your scene. The two
types of views within Maya are perspective and orthographic. You select and change views
using the Panels drop-down at the top of every viewport.

View Shading Lighting Show Renderer

Perspective 4
Orthographic 4
Look Through Selected

Panel
Hypergraph panel
Layouts

Saved Layouts

Tear OFF
Tear Off Copy

Panel Editor

Use the Panels drop-down to change views.

Click on any axis in the
view compass to quickly
change views to the corre-
sponding viewport.
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 viow [ERSEIEN Lighkng Show Renderer Panels

Wireframe 4
v Smooth Shade All

Smooth Shade Selecked Ttems

Flat Shads all

Flat Shade Selected ltems

EBounding Bowx

Points.

Shading

Each view can have its own level of shading for view-
ing objects at different levels of realism. If you are
creating models, you might want to view just the

Use default maberial
Wireframe on Shadad
¥-Ray

w Ohiject Transparency Sorting
Pohegon Transparency Sarting

wireframe, but others might want to view the fully
shaded and textured objects. The more realistic the

shading, however, the slower the interaction; so com- '""';‘:‘“‘Z"“"‘"“ ad
Backface Culling

plex scenes can bog down the system. One handy Smasth Wircframs _

option is shading only the selected items. Not only it 5

Apphy Current ko All

does this speed interaction in complex scenes, it
helps the selected items stand out.

The Shading drop-down on Wireframe shows a simple
the top of the viewport con-  outline of the object.
trols the shading level.

Flat Shade fills in the spaces ~ Smooth Shade displays a Hardware Texturing displays High Quality Rendering

between the wires. smooth object. textures. The quality of the shows advanced features
textures depends on the such as bumps and
graphics card. transparency.

B B

Navigation P

To navigate within a view, hold down the
Alt or Option key while clicking a mouse
button.

Additionally, pressing F frames the
current selection, and pressing A frames
everything in the current scene.

Tumble: Alt or Option Track: Alt or Option Dolly: Alt or Option
plus the left mouse plus the middle mouse  plus the right mouse
button rotates the button moves the button moves the
camera around a per- camera left/right and camera toward or away

spective view. up/down. from the subject.
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Selecting Objects

Objects in Maya can be NURBS (Non-Uniform Rational B-Spline) surfaces, m ’i 'x
polygonal surfaces, curves, cameras, lights, and joints, among others. :
Maya has three levels of selection: objects themselves, groups of objects
(hierarchies), and parts of objects (components). Maya also has a

sophisticated masking system that lets you select only the objects or A group of icons on the Status line
determines the selection mode.

Compénents

components you want.

[ J o
H 1 e ra rc h] e S You use hierarchies to logically group objects for

scene management, as well as to help create complex

Hierarchies are groups of objects. To create a animations. A good example is the lamp. The base of
hierarchy, select multiple objects, and then choose the lamp is the “root” node of the hierarchy; moving
Edit — Group. You can select a hierarchy by clicking this moves the child nodes, such as the arm and the
the Hierarchy icon on the Status line, from within the  head of the lamp. Adjusting a child node, however,
Hypergraph (choose Window — Hypergraph Scene such as the arm of the lamp, affects only those nodes
Hierarchy) or from within the Outliner (choose lower in the hierarchy, such as the head of the lamp.

Window — Outliner).

Q-
SGrech_Rerderig Optiows_Swom_Hep - .
\ |8 31 o [ 2w
- ‘ You can manage and select

hierarchies of objects in the
This object is actually made ...which are tied together in Hypergraph... ...as well as in the Outliner.
of several objects... a hierarchy.

Display Shaw Help

m;-Sufaoeshum
AR
polGuifacsihanet
HEAD
pokSuilazeSheped
BULE
@ defoublightset
@) defaukDbjectel

77 Bs
-
f
®
I
&
b

Handles Used to aid in  Curves Used to help
the selection of objects  build surfaces

[ ]
O b] e Cts Joints Used as Surfaces NURBS,

. bones to deform polygonal surfaces,
. . . . ' characters . subdivision
Maya supports a variety of object types, including surfaces, - surfaces or planes

curves, joints, and handles, among others. To select individual

objects or multiple objects, set the selection mode to Object g,\;'“— [N | s ‘ + ‘& ‘2 ‘ Q L@ ‘ # [Q ‘ ?
and select with the mouse. You can also select objects in the ...
Hypergraph or Outliner. Deformat1ons Clusters, .~ Rendenng Lights,
. . . . lattices, and other tools cameras, textures,
Using the selection masks on the Status line, you can refine | .1"to deform objects and other objects
object selection. By toggling the selection masks, you can Dynamics Particle - related to
select only the types of objects you want. systems and soft bodies rendering

used for special effects
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Components

You use components to modify and change the shape of an object, such
as a curve or a surface. Each type of object has different types of compo-
nents. A NURBS surface has components such as hulls and control ver-
tices (CVs), and a polygonal surface has vertices, edges, and faces. Using .
the selection masks helps you to limit the types of components selected:

II, Polygonal vertices Polygonal edges Polygonal faces

Quick Select serv [potd

Quick Select, located on the Status line, lets you enter the
name of an object to select it. This is handy when an object is
in a complex scene and hard to find. Using an asterisk (*)
selects all objects containing the characters, making it easy to
select all similar items with a few keystrokes. For example,
when selecting parts of a character, typing Hand* might select
everything related to that character’s hand. Devising and
sticking to a naming scheme can help tremendously when
working on large projects.




Selecting Objects

The Qutliner

Another way to select objects and manage hierarchies is with the Outliner. The Outliner
presents all the items in the scene as a hierarchical list. You can quickly scroll through this
list to select scenes, and objects or hierarchies of objects.

To open the Outliner, choose Window — Outliner. You can also configure the Outliner to
reside in a viewport using the viewport’s drop-down menus.

To select an item in the Outliner, left-click it. To select multiple items, left-click and drag
them. Holding down the Shift key lets you select objects in groups by clicking the first and
last item of the group. Holding down the Ctrl/88 key lets you add or subtract items from the
selection individually. You can easily rearrange hierarchies by middle-clicking the item and
dragging it.

Display Drop-down menu to control how much information i is i, Outliner
displayed. -
-l Display Show Help

Show Drop-down menu to show and hide types of objects. -~ —

persp
. . o top
Text filter Typing a name or a global (such as bolt*) displays front
only those objects that match the criteria. »
side
PR Fbx_Roat
Root node Highlighted in green, this is the root node of the Orani0
selected item(s). Omni02
Omni03
Selected item Selected items are highlighted in gray. -----........ =] Dummy01
JUSPREEEEE MotarCycle
Close hierarchy Left-clicking the minus sign (-) closes the , TheFork
hierarchy. WheelBack
: Break01
. s . SeatS
Open hierarchy Left-clicking the plus sign (+) opens the )
hierarchy. BackLights

Cables01

Egzoz
Foaoties

Second view Moving the bar along the bottom of the screen

gives you a second view of the hierarchy; useful when
managing complex scenes. i Bar03

Cover
Torus03
Tank
(® defaultLightset
(® detaultObjectset

(11
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Transforming Objects

Transformations change an object’s translation, rotation, and
scale. These changes are stored in the object’s transform node. Choose Modify > Freeze Trans-
formations to set all your objects’ current

You access the Transformation tools using the hot keys: W . . "
M E (R R (Scale). Y 1 1 h 1 transformations at their zero positions.
(Move), E (Rotate), R (Scale). You can also select these tools Choose Modify > Reset Transformations to

from the toolbox on the left side of the interface. set the transformations on selected objects
Each transformation tool has its own manipulator, and each back to zero, placing the objects at their ori-

manipulator is color coded. Red is the X axis, green is Y, and gin. This resets any transformations since

blue is Z. Left-clicking and dragging in the center of the the objects were created or since the last

manipulator moves the object on all available axes; clicking time you used Freeze Transformations.

and dragging an individual manipulator transforms the object
only on the selected axis. The Universal Manipulator tool com-
bines the functionalities of translating, rotating, and scaling
into one, easy-to-use tool.

Move manipulator Scale manipulator @ Rotate manipulator Universal manipulator

Coordinate Systems [

Transfor;atlorn Teals 3
. Mowe Tool o
Reset Transformations [ ] Rotate Tool o
Transformations can take place along a number of Fresze Transformations B scale Tool o
. . . . Universal Manipulator Chrl+t o
different XYZ coordinate systems. These primarily i:;p :Ilg:'l Objects S I o
T T N Tool
affect how an object is moved. You can change coor- oo Together Too o] MovelRotatefscale Tod
dinate systems using the options panel for each tool. Show Manipulator Tool
Evaluate Nodes » Default Object Manipulator >
Make Live Prapartional Modification Tool o
) Soft Modification Tool [u ]
Center Pivot
| Prefix Hierarchy Names. ..
IIII:I Search and Replace Names...
IZII:I Add Attrbute. .
= Edit Attribute...
Delete Attribute...
To access thg options for any Convert
command, click the small
box to the right of the com- Paint Scripts Tool
mand’s name in the menu. Paink Attrdbubes Yool




The Move Tool
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Move tool options (choose Modify —> Transformation Tools — Move Tool) select the coordi-

nate system for the Move tool.

Object space is aligned with
the selected object. If the
object is rotated, the
orientation of X, Y, and Z
rotate as well. ..

Local space is aligned with
the selected object’s parent.

LI Move Settings )
Move: ¢~ Object

" Along rotation axis
" Along live object axis
" Custom axis orientation

" Local
" Nomal

[o:0000

[0.0000

Orient Axis to Point

[0-.0000

Align Axis with Edge

Align Axis with Face

Normal space is aligned with

the individual normals when

World space is the default
coordinate system and has
its axis aligned with those of
the scene’s X, Y, and Z axes.

Discrete move: |

Relative: [~

Step size I 00

in component mode. Instead
of X, Y, and Z, Maya uses U, V,
and N for the coordinates.

The Move tool options panel

The Rotate Tool

Rotate tool options (choose Modify — Transformation
Tools — Rotate Tool) select the coordinate system for
the Rotate tool.

Pivots

The pivot is the center of each object’s coordinate
system. This is particularly important when using the
Rotate tool, because the object rotates around the
pivot.

To adjust the placement of the pivot, press Insert
or Home while in move mode. Once the pivot is in the
proper location, pressing Insert or Home locks the
pivot in place.

Another way to automatically adjust pivots is to
choose Modify — Center Pivot. This moves the pivot
to the geometric center of the object.

Constrains the
rotation to only
the X, Y, or Z axis

Rotates the object
about the world
space axes-.

Rotates the object
about the object
space axes-...

at a time
~ | Rotate Settings . : ;
Rotate mode: © Local " World " Gimbal
Snap rotate: |

ve: ¥

I Component use object pivat
IV Center as vitual Trackball

When the pivot is
moved to the cen-
ter of the wheel,

the wheel rotates

properly.

When the pivot is placed outside the
wheel, the wheel rotates around the
wrong center.
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Connecting Objects

In Maya, every object is a collection of intercon-

nected nodes. These nodes modify such items as the
object’s shape, shading, and construction history. To
control the attributes of these connections, you can

The Hypergraph shows the contents of a scene as a
network of boxes connected via lines. In this way, it
functions much like a graphical version of the OQut-
liner. The Hypergraph goes much deeper, however.
Not only does it show the hierarchical connections
between objects, but it also shows the way nodes and
their attributes are connected.

Choose Window — Hypergraph Scene Hierarchy to
open a hierarchical view of the Hypergraph, or

Graph Selects between

Edit Commands that let you
: displaying hierarchies or

collapse and expand
hierarchies.

are duplicated with the
Scene Hierarchy and
Input/Output connections :
icons. :

View Commands to frame
selected objects as well as
hierarchies or branches of
hierarchies. These functions "',
are duplicated with the

Frame All, Frame Selection,
Frame Hierarchy, and Frame
Branch icons.

connections. These functions .-

. ' -Options Manage the
: Hypergraph.

use the Attribute Editor, but the Hypergraph and the
Connection Editor give you control over the connec-
tions and dependencies themselves.

choose Window — Hypergraph Input And Output Con-
nections to open the Hypergraph showing the attrib-
ute connections. You can configure the Hypergraph
to reside in a viewport using the viewport’s drop-
down menus. You navigate in the Hypergraph the
same as you navigate in any view:

e Alt or Option plus middle mouse button for pan
e Alt or Option plus right mouse button for zoom

Rendering Commands used
to manage and display nodes -
related to rendering. :

~Help Help menu.

. -Bookmark icons Create and
./ manage bookmarks.

:: i Toggle freeform Toggles
. : i i between freeform and
. Show Options to show and - ;

: automatic layout of nodes.

R : Display Connections icons
* ! Displays the input/output

‘ connections for the selected

object.

Bookmarks Commands to
create bookmarks to easily
index parts of a complex
scene or hierarchy. These
functions are duplicated with
the Add Bookmark and Edit
Bookmark icons. )
Nodes Object nodes. -~~~

J nurbsSphere1

nurbssphered..,

Cellpse:
Expand

Expand Al
Frame Hiararchy
Frame Branch
Pename

Shiow

Hide

4’ nurbsSpharal

wishiy
boundngBadax
boundingBadin

boundngBoesize
ratate

scel=
transMinusRotatedhot
transhate

Right-clicking the body of a
node displays the main Hyper-
graph menu.

-- Display Hierarchy icons
Displays the scene hierarchy.

View icons Frame All, Frame
. Selection, Frame Hierarchy,
B and Frame Branch.

- Text filter Typing a name or
a global (such as bolt*)
displays only those objects
that match the criteria.

[~ Connections Connections
between nodes.

Carnect Cutput of: nurbsSphorel

Right-clicking along the
right edge of a node displays
the possible connections for
that node.
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In hierarchy mode (choose Graph — Scene Hierarchy), the
Hypergraph shows the objects in the scene as a tree. Each
object is represented as a box, with the hierarchy represented
as lines. Selecting the box in the Hypergraph also selects the
corresponding item in the scene.

To modify the hierarchy in the Hypergraph, select the
nodes, middle-click, and drag the line to the parent. To com- When you select freeform mode (choose Options —>

Layout — Freeform Layout), these boxes can be

pletely unparent a node, drag the line to an empty spot on the  arranged in any order. This is useful for creating

Hypergraph. graphic representations of the objects in the
scene, such as having the boxes represent the
joints of a character.

The Dependency Graph (choose Graph — Input And Output Connections)
is the graphical equivalent of the Attribute Editor. It lets you view the
nodes that comprise objects and visualize how those nodes are con-
nected. The Dependency Graph displays the connections for selected
objects only.

Connections are created automatically as the scene is constructed.
You can also make and break the connections manually to create all
sorts of relationships between objects. The motion of an object along
one axis can be used to drive the scale of another object, for example.

This fender is composed of four curves,
) ) ) . ) which are lofted together (choose Sur-
To delete a connection, click the line representing the connection and  faces — Loft) to create the surface.

press Del. To create a connection, move the mouse over the right end of
the originating node until the cursor changes, middle-click, drag to the
upstream node, and release. This opens a menu, which allows you to
select the parameters to be connected in the Connection Editor.

o

Curves Loft Deleted

The Dependency Graph shows how the Deleting the connection from one of ...also removes it from the resulting
four curve nodes are connected to the the curves to the loft node... surface.
loft node, which creates the surface.
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The Connection Editor

You use the Connection Editor (choose Window —> General Editors — Connection Editor) to
connect attributes. It is divided into two vertical panes. Each pane contains a list of attrib-
utes from the selected objects, which can then be selected and connected using the From

-> To button.

To load an object’s attributes into the Connection Editor, select the object and click
either Reload Left or Reload Right. To connect attributes, left-click to highlight them on

each side of the window.

Loads the selected object’s attributes in

the left pane.

Attributes Available
attributes are shown in
black, unavailable ones in

gray.

Selected attributes The -
selected attributes are
connected and highlighted in
blue.

Toggles the direction of the

connection.

{1 Connection Editor

Options  Left Display  Right Display Help

.- Loads the selected object’s attributes in

the right pane.

Reload Right

i Fieload Left { |
Outputs from -» to I Inputs
o cuved alle loftedS urfacs QJ
Caching El Caching El
MNode State
@ Bounding Box Wisibility
@ Center Intermediate Object
I atei Template
"""""" Inverse Matrix Ghosting
a “whorld M akrix ® Inst Obj Groups
@ whorld Inverse Matrix Use Object Color
@ Parent Matrix Object Color
@ Parent Inverse hatrix (] Draw Dveride
Visibiity Lod Visibilty
. Intermediate Object 5] Render Info
" Tempiate T .
Ghosting ® Ghost Custom Steps
@ Inst Obj Groups Ghost Frames
Use Object Calor Ghost Range Start
Object Colar i| Ghost Range End i|
curves il Ll loftedSurfacel
Clear &l I Remove I Ereak Make Close
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Projects in Maya can encompass many types of files: 3D geometry, texture maps, rendered
images. Organizing these files can be a challenge, but Maya provides a standard folder
structure for projects that keeps everything in the proper place. Maya is not limited to
this structure, however, and you can create and store your assets in any manner you
want. Productions that involve multiple artists can store all the files on a central server,
for example. Assets that are used in multiple projects can be stored in their own folder

structure.

Maya Folders

Each user on the system gets a Maya folder

in their home folder. This allows each user

to maintain their own preferences, such as

custom layouts, as well as have a place for

their own projects.

2 ) maya
=80
# () prefs
# () presets
) scripts -
# ) projects .-

The Maya folder

-+ Each version of Maya

maintains its own
folder for installing
custom preferences
and scripts.

-- A folder hierarchy

that contains Maya
projects.

This is where most
custom MEL scripts
should be saved.

-- Each project has its own folder and

B ) projects )
= ) default -

D dips-—
) data

) images -
) particles -

& [ renderData -

() depth

) iprimages

[ shaders
[ renderScenes -.
[ scenes--..
2 sound -
[ sourceimages .
D textures.

hierarchy. Maya creates the default
project, which you can copy to create
new project hierarchies.

- Animation clips used in the Trax

nonlinear animation editor.
Maya stores rendered images here.

Files related to the creation of particle
systems.

Temporary rendered images for the IPR

renderer, depth maps, and shaders are
stored here.

- Scene files ready to be rendered should

be stored here.

"~ Save your scene files in this folder.

" Audio files for use in animation.

* A folder that holds texture and image

maps.

Exported textures are stored here.

The Maya Projects folder
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Creating Projects

To create a new project, choose File > Project - New to open the New Project dialog box,
in which you can define the folder locations for the project. It's always best to click the Use
Defaults button at the bottom of the window, as it fills in most of the values automatically.

Name of the project. ---------

Location of the project hierarchy. -------.....] .

Where the Maya scenes are stored. ........_..

Data for other components of the scene,----
such as textures, particles, lights, and

so on. You can change individual entries

to point to other places on the network,
such as a shared texture library, for
example.

Folders used when exporting to
nonnative file formats. -----.._

Automatically fills in the entries with
the most commonly used values. --

Setting and Editing Projects

To set the current project, choose File — Project — Set to open a file

# New Project

Mame:  [Wew_Project

........... Location: [CFVPROJECTS

Browse..

:[Scene File Locations

"""""" Scenes |

jpmied Data Locations

Images ]

Source Images ]

Upsl

Sound |

Particles |

Render Scenes |

Depth |

IFR Images |

Shaders |

Tesdures |

el |

3dPaintTevhues |

mertalRay |

| = |Data Transfer Locations

Image ]

DHF |

IGES |

o8l |

RIE |

W’lre|

Mcwe]

]

Uze Defaultz

Cancel

Accepl I

browser in which you can select the new project folder.

To edit the current project, choose File > Project —> Edit Current to
open an instance of the project window, where you can change the fold-

ers as needed.

Browse for Falder

Set Projact (C:fDocuments and Settingsfad
KMy Do jmayafprojects/default)

- B3 Local Settings

File browser used to select a new
project




